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EPSON Stylus C44 User’s Guide

This User’s Guide contains instructions on printing with Windows® or on a 
Macintosh,® maintaining the EPSON Stylus® C44, solving basic problems, and 
specifications. To set up your printer and install your Windows XP or Macintosh 
software, see the Start Here sheet.

To install your Windows 98, Me, or 2000 printer software, see the Installing Software 
for Windows 98, Windows Me, and Windows 2000 booklet. This booklet also contains 
safety instructions, your printer warranty, and other important information.

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain additional hints for better printing.
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About Your Printer

Printing with your EPSON Stylus C44 printer is easy, friendly, and fast. Simple 
enough for even the most inexperienced user, the Stylus C44 prints everything from 
school reports to family photos with great results. 

The Stylus C44 includes Exif (Exchangeable Image File) Print format support, which 
lets your printer use information stored in your digital camera to print more accurate 
reproductions of digital camera images. 

For added value, the printer supports a wide range of EPSON® special media, 
including Glossy Photo Greeting Cards, Photo Stickers,® and special photo papers in a 
variety of sizes and finishes. Visit the EPSON StoreSM at www.epsonstore.com for a 
complete list.
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About Your Software

The CD-ROM that came with your printer includes all the software you need for 
printing. See your Start Here sheet for installation instructions.

■ Your printer driver runs your printer and lets you control how your documents 
look. You can’t print without it.

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

■ EPSON Software™ Film Factory™ is a photo management program that lets you 
organize, beautify, and print your photos in a flash. Supports Exif Print (except 
with Mac® OS X).

Note: With Exif Print, image settings such as white balance, contrast, and 
exposure time are saved in your digital photo files. If your digital camera supports 
Exif Print, you can use this technology when you print with Exif Print enabled 
applications like Film Factory.

■ EPSON PhotoCenterSM is EPSON’s free photo-sharing web site where you can 
store, organize, and share your photos; print high-resolution photos straight from 
the web; and create free online postcards with your photos. Your printer software 
installer lets you add a link to the EPSON PhotoCenter on your desktop.



8

Loading Paper

■ Single Sheets

■ Printing on Envelopes

■ Special Papers

Single Sheets

Make sure your printer and computer are turned on.

1. Place your paper against the right edge of the sheet feeder, behind the tab.

2. Press in the locking tab on the left edge guide and slide it against the paper.

3. Pull out the output tray extension.

Follow these guidelines when loading paper:

■ Always load the short edge first, even when you’re printing landscape oriented 
documents.

■ Load the printable side face up. It’s usually whiter or brighter than the other side.

■ Load letterhead or preprinted paper into the printer top edge first.

■ Don’t load paper above the arrow on the left edge guide.

Load paper 
behind the tab

Press the locking 
tab and slide the 
left edge guide 
against the paper
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■ Load the following media types one sheet at a time: Photo Quality Self Adhesive 
Sheets, Photo Stickers, and Panoramic Photo Paper.

■ If you’re using special media, follow the instructions that came with the media.

Printing on Envelopes

You can load up to 10 envelopes at a time. Follow these steps to print on No. 10 size 
envelopes:

1. Load the envelopes short edge first against the right edge of the sheet feeder, 
behind the tab. The printable side should be up, and the flap side should be down 
and on the left. 

2. Press in the locking tab on the left edge guide and slide it against the envelopes.

3. In your application software, set a left margin of approximately 3 inches. Set a top 
margin of approximately 2 inches. Then type the address.

4. Open your printer software and make the following settings:

■ For paper Type (Windows) or Media Type (Macintosh), select Plain Paper

■ For Orientation, select a Landscape option

■ For Paper Size, select the Envelope #10 option.

5. Do one of the following to preview of your envelope layout:

Windows: Click the Print Preview box, then click OK. Click Print in the Print 
window. 

Load the printable 
side up and the flap 
side down
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Macintosh OS X: Click the Preview button on the Print Settings menu.

Macintosh OS 8.6 to 9.x: Click the  button on the printer settings menu. Then 
click the Preview button that appears.

6. If you need to change the margins, cancel or close the preview window and adjust 
the margins in your application software. Then repeat step 4 and step 5.

7. When your preview looks okay, print the envelope:

Windows and Macintosh OS 8.6 to 9.x: Click the Print button on the Print 
Preview window.

Macintosh OS X: Select Print from your application software’s File menu. Then 
click the Print button on the window that appears.

Special Papers

EPSON offers the following special papers for the EPSON Stylus C44:

Paper name Size Part number

EPSON Premium Bright White Paper Letter (8.5 x 11 inches) S041586

EPSON Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

A4 (8.3 x 11.7 inches) S041061

Legal (8.5 x 14 inches) S041067

EPSON High Quality Ink Jet Paper Letter (8.5 x 11 inches) S041111

A4 (8.3 x 11.7 inches) S041117

EPSON Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

EPSON Glossy Photo Paper 

(EPSON Photo Paper)

4 x 6 inches S041134 
S041671

Letter (8.5 x 11 inches) S041141 
S041649
S041271 
S041272

A4 (8.3 x 11.7 inches) S041140

Panoramic (8.3 x 23 
inches)

S041145
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Printing in Windows

■ Printing from a Software Program

■ Selecting the Settings You Use Most Often

EPSON All-Purpose Glossy Paper Letter (8.5 x 11 inches) S041654

EPSON Photo Stickers Kit 
(CD-ROM/paper)

EPSON Photo Stickers (refill)

A6 (4.1 x 5.8 inches) S041144-KIT

A6 (4.1 x 5.8 inches) S041144

EPSON Ink Jet Transparencies Letter (8.5 x 11 inches) S041064

EPSON Photo Quality Self Adhesive 
Sheets

A4 (8.3 x 11.7 inches) S041106

EPSON Photo Quality Glossy Paper Letter (8.5 x 11 inches) S041124

A4 (8.3 x 11.7 inches) S041126

EPSON Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257

EPSON Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

EPSON Glossy Photo Greeting Card Kit Letter (8.5 x 11 inches) S041606

Paper name Size Part number
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Printing from a Software Program

Here’s what to do to print a basic document—such as a newsletter or school project. 
After you create your document in a software program, follow these steps to print. 

1. From the File menu, click Print. You see a Print window (your window may look 
different):

2. Make sure EPSON Stylus C44 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to 
open your printer 
software

Select your printer here
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You see your printer Properties (or Preferences) window.

4. Select the type of document you’re printing:

■ Draft: For rough drafts on plain paper. Saves ink.

■ Text: For text-only documents, like letters or reports. Delivers high-quality 
text printing.

■ Text & Image: For documents that have both text and images, like 
newsletters.

■ Photo: For photos and graphics, when you want good quality with faster 
printing.

■ Photo RPM: For photos or graphics, when you need highest quality printing. 
Because this setting increases resolution, it also increases print time.

5. Load the right paper for your document. See Loading Paper for instructions.

1 Choose your 
document type

2 Choose your 
paper type

3 Choose your 
paper size

4 Click OK
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6. If you loaded special paper, choose the correct paper type (click the arrow to scroll 
through the Type list). If you’re not sure which setting to select, see Selecting the 
Correct Paper Type.

 

7. Select your paper size (click on the arrow to scroll through the Size list).

8. If necessary, select your page orientation: Portrait for documents that are longer 
than they are wide, or Landscape for documents that are wider than they are 
long.

9. You can also make these settings:

■ PhotoEnhance: Improves the appearance of low-resolution and improperly 
exposed photos. Not available when Black Ink Only is selected.

■ ICM (Image Color Matching): Matches colors on your printout as closely as 
possible to the colors you see using ICM-compatible monitors or scanners.

■ Black Ink Only: Prints using only black ink.

■ Reverse Order: Prints your document so that the pages are in the right order 
when you retrieve them from the paper tray.

■ Print Preview: Lets you see what your printout will look like before you 
print.

Tip: For more information about printer settings, click the Help button, or 
right-click any item on the screen and then click What’s This?.

10. Click OK to return to the Print window. Then click OK (or Print) to start 
printing.



15

After a moment, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or restart printing. You can also see how much 
ink you have left. 

Caution: When you’re finished using your printer, make sure you press the 
power button to turn it off. Never use a power strip or external switch to turn 

off the printer.

Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you usually 
print one type of document in different programs—for example, color photos on 
letter-size paper—you can change the default printer settings for all your programs. 

1. Right-click the  printer icon on your taskbar (in the lower right corner of your 
screen). 

2. Select Printer Settings. You see your printer settings window, as shown in 
Printing from a Software Program.

3. Select the default settings you want to use for all your applications. Click OK 
when you’re finished.

Remember that you can always change the settings in your program when you want to 
print different types of documents.

Click to cancel printing

Click to pause or 
resume printing
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Printing With Macintosh OS X

■ Printing With the Minimize Margins Feature

Here’s how to print a basic document, such as a newsletter or school project, if your 
Macintosh is running OS X. Make sure you have paper in the printer, as described in 
Loading Paper. After you create your document, follow these steps to print it.

Note: If you’re using an application that’s compatible only with Macintosh Classic 
mode, follow the steps in Printing With Macintosh OS 8.6 to 9.x to print your 
document.

1. From the File menu, select Page Setup. You see a screen like this:

2. Select your printer from the Format for menu.

3. Select your paper size (click on the arrow to scroll through the Paper Size list).

4. If necessary, select your page orientation: for documents that are longer than 
they are wide, or or for documents that are wider than they are long.

Select your printer 
from the Format for 
pop-up menu
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5. Select Print from the File menu. You see a screen like this:

6. Select Print Settings from the pull-down menu. You see a group of settings like 
this:

7. Select the following settings:

■ Load the right paper for your document in the printer. If you loaded special 
paper, choose the correct paper type in the Media Type list. If you’re not sure 
which setting to choose, see Selecting the Correct Paper Type.

Click here and select 
Print Settings

Select the type of 
paper you loaded

Select the ink color

Select Automatic mode

Select higher quality 
or faster printing, or 
an in-between setting 
(if available)

Click Print
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■ Set the Ink option to Color to print a color document. To print a black text 
document, click Black.

■ Set the Mode option to Automatic. It’s the easiest way to get good printing 
results for most projects.

■ Set the slider to Quality or Speed to select high-quality printing, faster 
printing, or an in-between setting (if available). The slider may not be 
available for some paper types.

8. To select a specific print quality setting, click Advanced Settings and choose a 
setting from the Print Quality menu:

■ Economy or Economy Plus: For printing drafts on plain paper. Saves ink. 
(Economy Plus is only available if you select Black as the ink color.)

■ Normal: For everyday printing needs.

■ Fine: When you want a higher resolution for printing text or text and 
graphics.

■ Photo: For printing photographs.

■ Photo RPM: When you want the highest resolution for your photographs 
and you don’t mind the longer print time.

9. You can also choose other print settings by selecting these options in the 
pull-down menu:

■ Copies & Pages: To select the number of copies or a page range

■ Layout: To select page layout options.

■ Output Options: To save your print job as a PDF file.

■ Color Management: To select ColorSync® or adjust the color controls or 
gamma setting.

■ Summary: To view a list of all your selections.

■ Save Custom Setting: To save your selections for future use (not available 
with Mac OS X 10.2.x.).

10. When you’re ready to print, click Print. The Print Center icon appears in the 
dock on the bottom of your desktop.
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11. Click the Print Center icon. On OS X 10.2.x, double-click Stylus C44. You 
see a screen like this:

12. To monitor the progress of your print job, do one of the following:

■ Click the print job, then click Delete to delete it

■ Click the print job, then click Hold to pause printing

■ Click a print job marked “Hold” and click Resume to resume printing

■ If multiple print jobs are listed, click a print job, then click the Priority arrow 
to reorder the jobs (not available with Mac OS X 10.2.x).

Caution: When you’re finished using your printer, make sure you press the 
power button to turn it off. Never use a power strip or external switch to turn 

off the printer.

Printing With the Minimize Margins Feature

Follow the steps in the sections below to used the Minimize Margins feature if you 
need to print within 0.12 inch (3 mm) of the bottom of the page.

Adding the Minimize Margins Feature to Print Center

1. Open Print Center. You see the Printer List.

If your printer is shown in the list, go to step 2.
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If your printer isn’t listed, make sure it is turned on and connected to the 
Macintosh. Then go to step 2.

2. Click the printer name.

3. Click the Add or Add Printer button. You see another window listing your 
printer.

4. Click the printer name again. The Page Setup pull-down menu at the bottom of 
the screen becomes active.

5. Open the Page Setup pull-down menu and select All.

Click printer 
name

Click Add or 
Add Printer

Click printer 
name again

Select All in 
Page Setup 
menu
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6. Click the Add button. You see the Printer List again with the Minimize Margins 
feature available.

7. Close Print Center.

Using the Minimize Margins Feature

1. Open an application and create your print job.

2. When you’re ready to print, select Page Setup from the File menu.

3. Open the Format for pull-down menu and select Stylus C44 (Standard - 
Minimize Margins).

4. Select any other necessary page setup features, then click OK.

5. Select Print from the File menu.

Select printer and feature 
from the Format for menu
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6. Open the Printer pull-down menu and select Stylus C44 (Standard - Minimize 
Margins) again. Always check to make sure you selected the same setting you 
chose in the Page Setup window.

7. Select any other necessary print features, then click Print.

Printing With Macintosh OS 8.6 to 9.x

Here’s what to do to print a basic document—such as a newsletter or school project—
if your Macintosh is running OS 8.6 to 9.x. Make sure you have paper in the printer, 
as described in Loading Paper. After you create your document, follow these steps to 
print it. 

1. From the File menu, select Page Setup. You see the following:

2. Make sure C44 Series is selected. If not, select your printer in the Chooser.

3. Select your paper size (click on the arrow to scroll through the Paper Size list).

Select same printer and 
feature from Printer 
menu

Make sure you see 
C44 Series

Select your paper size

Select the orientation 
of your document
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4. If necessary, select your page orientation: Portrait for documents that are longer 
than they are wide, or Landscape for documents that are wider than they are 
long.

5. Then click OK.

Note: For more information about printer settings, click the ? button.

6. From the File menu, select Print. You see a window like the following:

7. Make the following settings:

■ Choose the paper you’re printing on (click the arrow to scroll through the 
Media Type list). If you’re not sure which setting to select, see Selecting the 
Correct Paper Type. 

■ Set the Ink option to Color to print a color document. To print a black text 
document, click Black.

■ Set the Mode option to Automatic. It’s the easiest way to get good printing 
results on all types of paper.

■ Set the slider in the Mode box to Quality or Speed to select high-quality 
printing, faster printing, or an in-between setting.

8. Click PhotoEnhance to improve the appearance of low-resolution and 
improperly exposed photos (works only when Color ink is selected).

9. Click Custom, and then select ColorSync to match the colors in your printout 
as closely as possible to those you see using ColorSync-compatible devices and 
applications.

Select higher quality or faster printing

Select the type of 
paper you loaded

Select Automatic mode

Select the 
ink color



24

10. To select a specific print quality setting, click Custom, then click the Advanced 
button that appears. You see the advanced screen. Choose a setting from the Print 
Quality menu:

■ Economy or Economy Plus: For printing drafts on plain paper. Saves ink. 
(Economy Plus is available only if you select Black ink.)

■ Normal: For everyday printing needs.

■ Fine: When you want a higher resolution for printing text or text and 
graphics.

■ Photo: For printing photographs.

■ Photo RPM: When you want the highest resolution for your photographs 
and you don’t mind the longer print time.

11. You can also do the following:

■ Click  to reduce or enlarge your image, print multiple layouts, or add a 
watermark.

■ Click  to turn on background printing.

■ Click  to change the Print button to Preview. You can then click it to 
preview your printout.

■ Click  to check your ink levels.
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12. Click Print to start printing. If you turned on background printing, you can select 
EPSON MonitorIV from the Application menu in the upper right of your screen. 
You see this dialog box:

Tip: If you’re not using background printing and you need to cancel printing, hold 
down the key and press the . (period) key.

Caution: When you’re finished using your printer, make sure you press the 
power button to turn it off. Never use a power strip or external switch to turn 

off the printer.

Selecting the Correct Paper Type

Your printer automatically adjusts itself for the type of paper you select in your print 
settings. That’s why the paper Type or Media Type setting is so important. It tells 
your printer what kind of paper you’re using and adjusts the ink coverage accordingly.

Click to cancel printing Click to check ink levelsClick to pause printing

Click to restart your print job

Click on the 
current print job 
or 
a waiting print 
job . . .

Then click here to 
view details of the 
selected print job 
and control print 
job priorities
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The table below lists the settings you should choose for your paper:

For this paper . . .

Select this Type or Media Type 

setting . . .

Plain paper sheets or envelopes

EPSON Premium Bright White Paper

Plain paper

EPSON High Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Matte Paper Heavyweight

EPSON Double-Sided Matte Paper

Matte Paper - Heavyweight

EPSON Glossy Photo Paper

EPSON Photo Paper

EPSON All-Purpose Glossy Paper

EPSON Photo Quality Glossy Paper

EPSON Glossy Photo Greeting Cards

Glossy Photo Paper

EPSON Photo Stickers Photo Quality Glossy Film

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Cleaning the Print Head

■ Running the Head Cleaning Utility

■ Examining the Nozzle Check Pattern

If your printouts are unexpectedly light, or dots or lines are missing from the image, 
you may need to clean the print head. This unclogs the nozzles so they can deliver ink 
properly. 

Print head cleaning uses ink, so clean it only if quality declines. 

This section explains how to clean the print head using the Head Cleaning utility. 
This is the recommended method when the printer is connected directly to your 
computer (not over a network). 

You can also clean the print head by holding down the maintenance button on 
the printer for three seconds (when the red error light is off). 

Caution: When you don’t turn on your printer for a long time, the print quality can 
decline. It’s a good idea to turn on your printer at least once a month to maintain 
good print quality.

Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red error light is 
off. (If the red light is flashing or on, you may need to replace the ink cartridge; 
see Replacing an Ink Cartridge for details.)

2. Do one of the following:

■ Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

■ Macintosh OS X: Double-click the Applications folder on your hard drive. 
Double-click EPSON Printer Utility, select the C44 Series printer, and click 
OK. Then click Head Cleaning.

■ Macintosh OS 8.6 to 9.x: Open the File menu and choose Page Setup or 
Print. Click the  utility button, then click the  Head Cleaning button.

3. Follow the instructions on the screen to clean the print head. Cleaning takes 
about 30 seconds, during which the printer makes some noise and the green 

power light flashes. 
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Caution: Never turn off the printer while the power light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.

4. When the power light stops flashing, run a nozzle check to confirm the print 
head nozzles are clean.

Make sure plain paper is loaded in the printer and click Print Nozzle Check 
Pattern. Then click Print. The nozzle check pattern prints (see the next section 
for details). 

5. If the nozzle check pattern has no gaps or lines, click Finish.

If the pattern has white lines, click Clean to clean the print head again. 

If you don’t see any improvement after cleaning three or four times, check the 
solutions in Problems and Solutions. You can also turn the printer off and wait 
overnight—this allows any dried ink to soften—and then try cleaning the print 
head again. 

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. Each colored square should be solid, 
with no gaps or lines, as shown:

If your printout looks okay, you’re done. 

If you see any white lines or gaps (as shown), clean the print head again; see Running 
the Head Cleaning Utility for instructions.

Purchasing Ink Cartridges

Use these EPSON ink cartridges within six months of installing them and before the 
expiration date on the package:
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■ Black ink cartridge: T036

■ Color ink cartridge: T037

Caution: To ensure good results, use genuine EPSON ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered by 
EPSON’s warranty.

When you need new ink cartridges, contact your dealer or call EPSON at 
(800) 873-7766 or visit the EPSON Store at www.epsonstore.com (U.S. sales only). 
In Canada, please call (800) 463-7766 for dealer referral. 

Replacing an Ink Cartridge

■ Checking the Ink Supply

■ Ink Cartridge Precautions

■ Removing and Installing Ink Cartridges

Checking the Ink Supply

When the red error light flashes, an ink cartridge is low on ink. This is a good 
time to make sure you have a new cartridge. When the red error light stays on, 
you may need to replace one of the cartridges.

Note: The red error light also comes on if your paper runs out or is jammed, 
so make sure you check your paper before replacing a cartridge. 

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if the error light is off. 

To check your ink supply, do one of the following:
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■ Windows: Double-click the  printer icon on your taskbar (in the lower right 
corner of your screen). You’ll see a window like the one below showing the ink 
remaining in each cartridge. 

■ Macintosh OS X: Double-click the Applications folder on your hard drive. 
Double-click EPSON Printer Utility, select the C44 Series printer, and click 
OK. Then click EPSON StatusMonitor. You see a window showing the ink 
remaining in each cartridge.

■ Macintosh OS 8.6 to 9.x: Open the File menu and choose Print. Click the 
ink icon. You see a window showing the ink remaining in each cartridge.

Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them thoroughly with water.

Caution: To avoid damaging the printer, never move the print head (ink cartridge 
holders) by hand.

You cannot print if either ink cartridge is empty. Leave the empty cartridge 
installed in the printer until you have obtained a replacement. Otherwise the ink 
remaining in the print head nozzles may dry out.
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Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start the ink 
cartridge replacement procedure, you must complete all the steps in one session. 

1. Make sure the printer is turned on and not printing (the green power light 
should be on, but not flashing). Then open the printer cover.

2. Press the maintenance button for 6 seconds. The print head moves to the 
cartridge replacement position.

Note: If both cartridges need replacing, the print head moves to the black 
cartridge position first.

The black cartridge is on the left, and the color cartridge is on the right.

Caution: Don’t touch the ink cartridge sensor above the print head, as shown 
below:
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3. Pull up the ink cartridge clamp and remove the cartridge. Dispose of it carefully.

4. Unpack the new cartridge and remove the yellow tab.

Caution: You must remove the yellow tape from the top of the cartridge or you 
will permanently damage it. 

Be careful not to touch the green chip on the front of the cartridge; you might 
damage the cartridge.

Black 
cartridge

Color 
cartridge

Don’t touch the 
green chips
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5. Insert the new cartridge and press down firmly on the clamp. Make sure the 
clamp is closed completely.

6. Press the maintenance button.

If the other cartridge needs to be replaced, the print head moves into loading 
position. Repeat step 3 through step 6.

Caution: Don’t move the print head by hand; you could damage the printer. 
Always use the maintenance button.

7. Wait until ink charging is finished. (The green power light stops flashing and 
the red error light goes out.) Ink charging takes about 30 seconds.

8. Close the printer cover.

Now you’re ready to print again. 

If the red error light remains on and the printer continues to make noise for 
more than five minutes, open the printer cover and press the power button to turn 
the printer off. Then make sure that the ink cartridge clamps are completely closed. 
Close the printer cover and press the maintenance button to finish ink charging. 
If that doesn’t work, contact EPSON as described in Where To Get Help.

Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to align the print 
head. Your printer must be connected directly to your computer (not over a network) 
to use the Print Head Alignment utility. 
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Caution: Load plain paper that’s at least 8.27 inches (210 mm) wide to prevent 
ink from spraying inside the printer and smudging your printouts. 

1. Make sure the printer is turned on, but not printing, and letter-size plain paper is 
loaded.

2. Do one of the following:

■ Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen) and select Print Head Alignment.

■ Macintosh OS X: Double-click the Applications folder on your hard drive. 
Double-click EPSON Printer Utility, select the C44 Series printer, and click 
OK. Then click Print Head Alignment.

■ Macintosh OS 8.6 to 9.x: Open the File menu and choose Page Setup or 
Print. Click the  utility button, then click the  Print Head Alignment 
button.

3. Follow the instructions on the screen to print a test page. You see this window:

4. On the printed page, select the pattern that shows the two vertical lines most 
precisely printed on top of each other. You may need to use a magnifying glass.

Select one pattern each for rows 1, 2, and 3. Then enter the number of the best 
pattern for each row in the corresponding boxes on the screen.

5. Click Realignment to print another test page. Make sure the pattern numbered 8 
in each row is the best aligned. If not, repeat step 4 and step 5.
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6. When you’re finished, click Finish. 

Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. 

1. Turn off the printer and disconnect the USB cable and power cord.

2. Remove all paper, then use a soft brush to clean any dust or dirt from the sheet 
feeder.

3. Clean the exterior of the printer with a soft, damp cloth.

Caution: Don’t clean or remove the grease from the guide rails shown below.

Caution: Don’t touch any gears inside the printer.

Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can 
damage the printer components and case. 

Don’t get water on the printer components and don’t spray lubricants or oils 
inside the printer. 

Don’t use any cleaning sheets included with special paper; they may jam inside 
the printer.

Don’t clean 
the guide rails
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Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in 
its original box or one of a similar size. 

Caution: To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

Be sure to remove the tape used in step 4 after installing the printer in its new 
location.

1. Turn on the printer, wait until the print head (ink cartridge holders) locks in the 
far right position, then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then disconnect both the 
printer cable and the power cord from the printer.

3. Remove any paper from the printer and remove the paper support.

4. Open the printer cover. Secure the print head to the printer with tape as shown, 
then close the printer cover.

5. Push in the output tray.

6. Repack the printer and its attachments in the original box using the protective 
materials that came with them.

Keep the printer level as you transport it. 

After transporting the printer, remove the tape securing the print head and test your 
printer. If you notice a decline in print quality, clean the print head (see Cleaning the 
Print Head); if output is misaligned, align the print head (see Aligning the Print 
Head). 

Tape the print 
head to the printer 
case
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Printer Parts

Diagnosing Printer Problems

■ Checking the Printer’s Lights

■ Running a Printer Check

Checking the Printer’s Lights

If the printer’s lights come on or flash, check the explanations listed below.

Lights Explanation

Green power 
light flashes

The printer is receiving a print job, replacing an ink cartridge, 
charging ink, or cleaning the print head.

Power button 
and light

Maintenance button 
and error light

Paper support

Printer cover

Output tray

Left edge guide
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
itself or some other source. The printer check also shows how much black and color 
ink you have left.

1. Make sure both the printer and computer are turned off. Then disconnect the 
USB cable from the printer.

Red error light 
is on

Your paper ran out, ink ran out, or paper is jammed. You may 
also see a message on your screen.

If paper is out, load more paper, then press the 
maintenance button to resume printing. 

If paper is jammed, press the maintenance button to eject 
the paper. If that doesn’t work, turn off the printer, open the 
cover, and pull the paper out from the front, including any torn 
pieces. Then turn on the printer, reload paper, and press the 

maintenance button.

If you see an ink out message on your screen, you need to 
replace one of your ink cartridges as described in Replacing an 
Ink Cartridge.

Red error light 
flashes

One of the ink cartridges is low. Make sure you have a 
replacement cartridge. To determine which cartridge is low, 
check the ink level as described in Checking the Ink Supply.

Green power 
light is off and red 

error light is on

Paper may be blocking movement of the print head. Turn off 
the printer, open the cover, and remove any jammed paper or 
other foreign objects. Then turn the printer on again. If the lights 
are still on, contact your dealer or EPSON; see Where To Get 
Help for contact information.

Green power 
light and red 

error light flash 

The printer may have an internal error. Turn off the printer, wait 
a few seconds, and turn it on again. If the lights are still flashing, 
contact your dealer or EPSON; see Where To Get Help for 
contact information.

Green power 
light and red 

error light are 
on after installing an 
ink cartridge

One of your ink cartridges is installed incorrectly. Follow the 
instructions in Removing and Installing Ink Cartridges to reinstall 
the cartridge.
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2. Make sure letter-size or larger plain paper is loaded in the printer.

3. Hold down the maintenance button, then press and release the power 
button. Continue holding down the maintenance button until the green 

power light starts to flash, then release it.

The printer prints one page showing its ROM version number, the ink counter 
code, and a nozzle check pattern. (If the pattern has lines, you need to clean the 
print head; see Cleaning the Print Head.)

4. Turn off the printer after it prints the check page. Then reconnect the cable and 
turn on your printer and computer.

■ If the check page prints, the problem probably lies in your software settings, 
the USB cable, or your computer. It’s also possible that your software may not 
be installed correctly. See Reinstalling Printer Software for instructions on 
reinstalling the printer software.

■ If the check page doesn’t print, you may have a problem with your printer. 
Try the suggestions in Problems and Solutions. If nothing works, contact your 
dealer or EPSON as described in Where To Get Help.

Problems and Solutions

■ Setup and Software Installation Problems

■ Printer Problems

■ Print Quality Problems

■ Paper Feeding Problems

■ Miscellaneous Printout Problems

Setup and Software Installation Problems

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.



40

The printer makes noise after ink cartridge installation.

■ The first time you install ink cartridges, the printer must charge its print head for 
about 90 seconds. Wait until charging finishes (the green power light stops 
flashing) before you turn off the printer, or it may charge improperly and use 
excess ink the next time you turn it on. 

If the printer stops moving or making noise, but the green power light is still 
flashing after 5 minutes, turn off the printer. If the light is still flashing when you 
turn it back on, contact EPSON as described in Where To Get Help.

■ Turn off the printer, then make sure the ink cartridge clamps are locked down 
completely and no packing material remains in the printer. Wait a moment, then 
turn the printer back on to clear the error.

You’re having problems installing the printer software.

■ Make sure your printer is turned on and the USB cable is securely connected at 
both ends. Then carefully follow the installation instructions on the Start Here 
sheet or the Installing Software for Windows 98, Windows Me, and Windows 2000 
booklet. Also make sure your system meets the requirements listed in System 
Requirements.

■ Close your other programs, including any screen savers and virus protection 
software, and install again.

■ If you’re running Macintosh OS 8.6 to 9.x and your printer icon (C44 Series) 
doesn’t appear in the Macintosh Chooser, you may have too many items in the 
Chooser. Delete any unused items and check the Chooser again.

■ For Windows 2000, if you see an error message or your software doesn’t install 
correctly, you may not have software installation privileges. Contact your System 
Administrator.

■ In Windows 2000 or XP, don’t select Block under Control Panel > System > 
Hardware > Driver Signing; select Ignore or Warn instead.

■ Make sure your Windows system was not upgraded from Windows 95. The USB 
Printer Device Driver may not install correctly.

■ Make sure the USB Controller is working properly in Device Manager. See your 
Windows help system for details. If it’s not working, contact your computer 
manufacturer.
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Printer Problems

Only the green power light is on, but nothing prints.

■ Make sure the USB cable is connected securely and that the cable meets the 
requirements listed in System Requirements.

■ Run a printer check as described in Running a Printer Check. If the check page 
prints, make sure your software is installed correctly. 

The printer sounds as though it is printing, but nothing prints.

■ Make sure the print head nozzles are not clogged. To clean the print head, see 
Cleaning the Print Head.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, 
stable surface that extends beyond the printer base in all directions.

Your printer makes noise when you turn it on or after it has been sitting for 
awhile.

Your printer is performing routine maintenance.

Printing is too slow.

Make sure your system meets the requirements listed in System Requirements. If 
you’re printing a high-resolution image, you need more than the minimum 
requirements listed. You may also need to:

■ Clear space on your hard drive or run a defragmentation utility.

■ Close programs that you’re not using.

■ Increase your system’s memory.

For the fastest printing, try these tips:

■ Choose black ink in your printer software if your document doesn’t include color.

■ For Windows, choose Draft for Quality Type.

■ For Macintosh, set the Quality/Speed slider to Speed.

■ If your printer is connected to a hub, disconnect unused USB devices.
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Print Quality Problems

You see banding (light lines).

■ The print head nozzles may need cleaning; see Cleaning the Print Head for 
instructions. 

■ Make sure the paper Type or Media Type setting matches the paper you loaded; 
see Selecting the Correct Paper Type for guidelines.

■ Make sure the printable side of the paper is face up. It’s usually whiter or shinier.

■ The ink cartridges may need replacing; see Replacing an Ink Cartridge for 
instructions.

■ If you have a Macintosh, try using Automatic mode. See Printing With 
Macintosh OS X or Printing With Macintosh OS 8.6 to 9.x for instructions.

■ Run the Print Head Alignment utility; see Aligning the Print Head for 
instructions.

Your printout is blurry or smeared.
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■ Make sure your paper isn’t damp or curled, or loaded face down (the printable 
side should be face up).

■ Use a support sheet with special paper, or try loading your paper one sheet at a 
time.

■ Use EPSON papers to ensure proper saturation and absorption of genuine 
EPSON inks. 

■ Remove each sheet from the output tray as it is printed, especially if you’re 
printing on transparencies.

■ Avoid handling printouts on glossy paper or transparencies for a few hours to 
allow the ink to set.

■ If ink smears on the back of a printout, clean the inside of the printer as described 
in Cleaning the Printer.

Your printout is faint or has gaps.

■ The print head nozzles may need cleaning; see Cleaning the Print Head for 
instructions. 

■ The ink cartridges may be old or low on ink. See Replacing an Ink Cartridge for 
details. 

■ Make sure the paper Type or Media Type setting matches the paper you loaded. 
See Selecting the Correct Paper Type for guidelines.

■ Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, 
reload a new stack of paper with the printable side up; it is usually whiter or 
shinier than the other side.
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You see wrong or missing colors.

■ Make sure your printer software is not set to use black ink only.

■ The print head nozzles may need cleaning; see Cleaning the Print Head for 
instructions.

■ The ink cartridges may be old or low on ink. See Replacing an Ink Cartridge for 
details.

■ Try turning off PhotoEnhance. 

■ For Macintosh, try using Automatic mode.

■ For Macintosh, try changing the Gamma setting; see Printing With Macintosh 
OS X or Printing With Macintosh OS 8.6 to 9.x.

■ Your printed colors can never exactly match your on-screen colors. However, you 
can use a color management system to get as close as possible. Try using the ICM 
(Windows) or ColorSync (Macintosh) setting. 

Your printout is grainy.

■ Try using a higher quality paper.

■ Select Photo RPM for Quality Type (Windows) or Print Quality (Macintosh). 
Remember that this setting increases print time.

■ Run the Print Head Alignment utility; see Aligning the Print Head for 
instructions.

■ You may need to increase the image resolution or print it in a smaller size; see 
your software documentation.

Paper Feeding Problems

Paper doesn’t eject fully or is wrinkled.

■ If the paper doesn’t eject fully, you may have set the wrong paper size. Press the 
maintenance button to eject the paper, and then select the correct paper size.

■ If it’s wrinkled when it ejects, the paper may be damp or too thin. See Paper for 
paper specifications.
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Paper doesn’t feed correctly or jams in the printer.

■ If paper doesn’t feed, remove it from the sheet feeder. Reload it against the right 
edge, behind the tabs, then slide the left edge guide against the paper.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the 
edges to separate the sheets, then reload it.

■ If paper jams, press the maintenance button for several seconds to clear the 
jam. If that doesn’t work, open the cover and pull the paper out from the front, 
including small pieces that may have torn off. Reload the paper and press the 

maintenance button.

If your paper loads incorrectly or jams frequently:

■ Use new, smooth, high-quality paper, loaded printable side up.

■ Fan the edges of the stack of paper to separate the sheets.

■ Don’t load paper above the arrow mark inside the left edge guide.

■ Place the paper against the right edge behind the tab. Slide the left edge guide 
against it, but not too tightly. 

Miscellaneous Printout Problems

The image is inverted, as if viewed in a mirror.

■ Turn off the mirror setting in your application program. 

■ For Macintosh, turn off Flip Horizontal in the Advanced window of your printer 
driver (Macintosh OS 8.6 to 9.x) or Print Settings window (Macintosh OS X).

The printer prints blank pages.

■ Make sure your printer is selected in Windows. For Macintosh OS X, open the 
Print Center and make sure your printer is selected in the Printer List. For 
Macintosh OS 9.x or earlier, make sure your printer is selected in the Chooser.

■ The print head nozzles may need cleaning; see Cleaning the Print Head for 
instructions. 
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The margins are incorrect.

■ Make sure the paper settings are correct for your paper size. For instructions, see 
Printing in Windows, Printing With Macintosh OS X, or Printing With 
Macintosh OS 8.6 to 9.x.

■ Use the Print Preview option in your printer software to check your margins 
before you print.

■ Make sure your paper is positioned next to the right side of the feeder.

You see incorrect characters.

■ Make sure the USB cable is securely connected and meets the requirements in 
System Requirements. Then try printing again.

■ Make sure your printer is selected in your software, or is set as the active printer in 
the Macintosh Chooser (OS 8.6 to 9.x) or Print Center (OS X). 

■ If you’re using a switch box or USB hub with your printer, connect the printer 
directly to your computer.

Reinstalling Printer Software

■ Windows

■ Macintosh OS X

■ Macintosh OS 8.6 to 9.x

Windows

You can reinstall your printer software over your currently installed printer software. 
Make sure the printer is connected to your computer, then follow these steps:

1. Turn the printer on. Then insert the EPSON CD-ROM in your drive. If you see 
the Options Menu, go to step 3.

If you don’t see the Options Menu, continue with step 2.

2. Windows XP: Click Start, then click My Computer. Double-click  EPSON. 
You see the Options Menu.
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Other Windows systems: Double-click My Computer on your desktop, then 
double-click  EPSON. You see the Options Menu.

3. Click Reinstall Printer Driver. Then follow the instructions on the screen to 
reinstall your driver.

4. Click Exit to close the Options Menu.

Macintosh OS X

You can reinstall your printer software over your currently installed printer software. 
Follow these steps: 

1. Insert the EPSON CD-ROM in your drive.

2. Double-click the  EPSON CD-ROM icon, and then double-click the 
EPSON OSX Installer icon.

3. At the Main Menu, select Install Printer Driver. ( You may be asked to enter an 
administrator password.)

4. Follow the on-screen instructions to upgrade the printer software and restart your 
Macintosh.

Macintosh OS 8.6 to 9.x

Follow these steps to uninstall your printer software first:

1. Insert your printer software CD-ROM. 

2. Double-click the EPSON CD-ROM icon (if necessary) and double-click the 
 EPSON OS9 Installer icon. The Main Menu appears.

3. Click Install Printer Driver. On the installer screen, click the arrow in the Easy 
Install list at the top and select Uninstall. Then click the Uninstall button at the 
bottom and follow the instructions.

4. Restart your Macintosh, then follow the instructions on the Start Here sheet to 
reinstall your software.
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Where To Get Help

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed below:

You can purchase ink cartridges, paper, manuals, and accessories from EPSON at 
(800) 873-7766, or visit the EPSON Store at www.epsonstore.com (U.S. sales only). 
In Canada, please call (800) 463-7766 for dealer referral.

Service Access

World Wide 
Web

From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download drivers 
and other files, look at product documentation, access 
troubleshooting information, and receive technical advice through 
e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, 
seven days a week. To use these services, you must have a touch 
tone telephone and call (800) 922-8911. Your SoundAdviceSM 
Express Code is 70440. Use this code to quickly select the EPSON 
Stylus C44 in SoundAdvice.
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System Requirements

■ Windows System Requirements

■ Macintosh System Requirements

Windows System Requirements

To use your printer and its software, your system should have: 

■ A Microsoft® Windows compatible PC with a Pentium®-equivalent processor 
(233 MHz or faster recommended) 

■ Microsoft Windows XP, Windows 2000, Windows Me, or Windows 98

■ At least 64MB RAM (128MB recommended)

■ 100MB free hard disk space (200MB or more recommended)

■ VGA or better display adapter and monitor

■ 2x CD-ROM or DVD drive for installing the printer software (4x or faster 
recommended)

■ A shielded USB “AB” cable up to 6.5 feet (2 meters) long.

Macintosh System Requirements

To use your printer and its software, your system should have: 

■ An Apple iMac™ series or Power Macintosh® G3 or G4 with built-in USB port

■ Macintosh OS 8.5.1 through 9.x, OS X 10.1 or higher (Macintosh OS 9.0 or 
later recommended)

■ At least 32MB RAM for OS 8.6 through OS 9.x (64MB recommended); 128MB 
RAM recommended for OS X

■ At least 100MB free hard disk space (200MB recommended)

■ VGA display or better

■ 2x CD-ROM or DVD drive for installing the printer software (4x or faster 
recommended)
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■ A shielded USB “AB” cable up to 6.5 feet (2 meters) long.

Specifications

■ Printing

■ Paper

■ Ink Cartridges

■ Mechanical

■ Electrical

■ Environmental

■ Safety Approvals

Printing

Paper

Note: Poor quality paper may reduce print quality and cause paper jams or other 
problems. If you encounter problems, switch to a higher grade paper.

Do not load curled or folded paper.

Avoid extremes in temperature or humidity when printing. Optimum printing 
temperature ranges from 55 to 77 °F, and optimum humidity ranges from 40 to 
60% RH.

Store EPSON Self-Adhesive Sheets under the following conditions: 59 to 86 °F, 
and 20 to 60% RH.

Printing method On-demand ink jet

Nozzle configuration Black: 48 nozzles

Color: 45 nozzles (15 each: cyan, magenta, yellow)

Print direction Bidirectional with logic seeking

Input buffer 12KB
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Plain Paper, All-Purpose Glossy Paper, Premium Bright 
White Paper, Photo Quality and High Quality Ink Jet Paper 

Envelopes

Size Letter (8.5 x 11 inches)

Half letter (5.5 x 8.5 inches)

Legal (8.5 x 14 inches)

Executive (7.25 x 10.5 inches)

A4 (8.3 x 11.7 inches)

A5 (5.8 x 8.27 inches)

User-defined: 
Width: 3.5 to 9.5 inches
Length: 3.5 to 44 inches

Paper types Plain bond paper or special paper distributed by EPSON

Thickness (for plain bond 
paper)

0.003 to 0.004 inch

Weight (for plain bond 
paper)

17 to 24 lb (64 to 90 g/m2)

Size No. 10 (4.13 x 9.5 inches)

DL (4.33 x 8.7 inches)

C6 (4.49 x 6.38 inches)

132 x 220 mm (5.2 x 8.7 inches)

Paper types Plain bond paper, airmail

Thickness 0.006 to 0.02 inch

Weight 12 to 20 lb (45 to 75 g/m2)
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Glossy Photo Paper and Photo Paper

Ink Jet Cards

Transparencies, Photo Quality Glossy Paper, and Glossy 
Photo Greeting Cards

Self Adhesive Sheets

Photo Stickers

Matte Paper Heavyweight and Double-Sided Matte Paper

Size Letter (8.5 x 11 inches)

4 x 6 inches

Panoramic (8.3 x 23.4 inches)

A4 (8.3 x 11.7 inches)

Paper types Special paper distributed by EPSON

Size A6 (4.1 x 5.8 inches)

Paper types Special paper distributed by EPSON

Size Letter (8.5 x 11 inches)

Paper types Special paper distributed by EPSON

Size A4 (8.3 x 11.7 inches)

Paper types Special paper distributed by EPSON

Size A6 (4.1 x 5.8 inches) with 16 frames

Paper types Special paper distributed by EPSON

Size Letter (8.5 x 11 inches)
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Printable Area

Note: You can extend the minimum bottom margin to 0.12” (3 mm) using the 
Minimize Margins feature, however print quality may decline in the expanded 
area. Before printing large jobs using an extended margin setting, print a single 
sheet to confirm printout quality.

Paper types Special paper distributed by EPSON

Minimum top margin (A) 0.12 inch (3.0 mm)

Minimum left margin (B-L) 0.12 inch (3.0 mm)

Minimum right margin (B-R) 0.12 inch (3.0 mm)

Minimum bottom margin (C) 0.49 inch (12.5 mm)

A

B-L B-R

C

Single sheets or ink jet cards Envelopes
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Ink Cartridges

* The figure given is based on continuous printing after ink replacement. The actual print capacity 
may vary.

** Ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution: To ensure good results, use genuine EPSON cartridges and do not refill 
them. Other products may cause damage to your printer not covered by EPSON’s 
warranties.

Don’t use an ink cartridge if the date on the package has expired.

Specification Black cartridge (T036) Color cartridge (T037)

Color(s) Black Cyan, Magenta, Yellow

Print capacity* 330 pages using ISO 
Letter Pattern 10561, 220 
pages at 5% in 
calculation, except for the 
initial ink cartridge 

180 pages, 5% each CMY 
(total 15%) in calculation, 
except for initial ink cartridge

Cartridge life Within 6 months after opening package at 77 °F (25 °C)

Storage temperature −4 to 104 °F (−20 to 40 °C) 

1 month at 104 °F (40 °C)

Transit temperature −22 to 140 °F (−30 to 60 °C)

1 month at 104 °F (40 °C); 120 hours at 140 °F (60 °C)

Freezing temperature** 3.2 °F (−16 °C) −0.4 °F (−18 °C)

Dimensions
(W x D x H)

0.78 x 2.08 x 1.52 inches 

(19.8 x 52.7 x 38.5 mm)

1.69 x 2.08 x 1.52  inches 

(42.9 x 52.7 x 38.5 mm)
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Mechanical

Electrical

Note: Check the label on the back of the printer for your printer’s voltage.

Paper feed method Friction

Paper path Sheet feeder, top entry

Sheet feeder capacity 100 sheets of 17 lb (65.8 g/m2) paper

Dimensions Storage
Width: 16.7 inches (423 mm) 

Depth: 9.0 inches (229 mm)

Height: 6.8 inches (172 mm)

Printing
Width: 16.7 inches (423 mm)

Depth: 18.1 inches (459 mm)

Height: 10.9 inches (277 mm)

Weight 5.47 lb (2.48 kg) without the ink cartridges

Input voltage range 90 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4 to 0.2 A

Power consumption Approximately 19 W (ISO10561 Letter Pattern)

Approximately 3.0 W Sleep mode

Approximately 2.7 W Power Off mode
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Environmental

Note: Stored in shipping container

Safety Approvals

Temperature Operation: 50 to 95 °F (10 to 35 °C)

Storage**: −4 to 140 °F (−20 to 60 °C) 

1 month at 104 °F (40 °C) 

Transit**: –4 to 140 °F (–20 to 60 °C) 

120 hours at 140 °F (60 °C)

Humidity (without 
condensation)

Operation: 20 to 80% RH

Storage**: 5 to 85% RH

Safety standards UL 1950, CSA C22.2 No. 950 

EMC FCC part 15 subpart B class B

CSA C108.8 Class B
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Appendix

■ Copyright Notice

■ A Note Concerning Responsible Use of Copyrighted Materials

■ Trademarks

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise, without the prior written permission of 
SEIKO EPSON CORPORATION. The information contained herein is designed 
only for use with this EPSON printer. EPSON is not responsible for any use of this 
information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the 
purchaser of this product or third parties for damages, losses, costs, or expenses 
incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this 
product or unauthorized modifications, repairs, or alterations to this product, or 
(excluding the U.S.) failure to strictly comply with SEIKO EPSON 
CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems 
arising from the use of any options or any consumable products other than those 
designated as Original EPSON Products or EPSON Approved Products by SEIKO 
EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted 
Materials

Ink jet printers, like photocopiers, conventional cameras, digital cameras, and 
scanners, can be misused by improper copying and reprinting of copyrighted material. 
While some countries’ laws permit limited copying of copyrighted material in certain 
circumstances, those circumstances may not be as broad as some people assume. 
EPSON encourages each user to be responsible and respectful of the copyright laws 
when using ink jet printers, scanners, and digital cameras.
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Trademarks

EPSON, EPSON Stylus, and EPSON Photo Stickers are registered trademarks of 
SEIKO EPSON CORPORATION.

EPSON PhotoCenter, SoundAdvice, and EPSON Store are service marks, and 
EPSON Software and PhotoEnhance are trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only 
and may be trademarks of their respective owners. EPSON disclaims any and all 
rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or 
service.
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